AYAKKABI VE SARACİYE TEKNOLOJİSİ

MESLEKİ YABANCI DİL 1
(SARACİYE İNGİLİZCE)

Ankara, 2012
Bu modül, mesleki ve teknik eğitim okul/kurumlarında uygulanan Çerçeve Öğretim Programlarında yer alan yeterlikleri kazandırmaya yönelik olarak öğrencilere rehberlik etmek amacıyla hazırlanmış bireysel öğrenme materyalidir.

Milli Eğitim Bakanlığına ücretsiz olarak verilmiştir.

PARA İLE SATILMAZ.
**KOD** | **222YDK041**  
---|---  
**ALAN** | Ayakkabı ve Saracıye Teknolojisi  
**DAL/MESLEK** | Saracıye Üretimi  
**DAL/MESLEK** | Saracıye Modelistliği  
**MODÜLÜN ADI** | Meslek İngilizcesi 1  
**MODÜL TANITIMI** | Saracıye modelistliği; tasarım, kalıp ve bilgisayarda modelllemeye kullanılan çizim komutları ile ilgili konuların İngilizce olarak anlatıldığı bir öğrenme materyalidir.  
**SÜRÜ** | 40/32  
**ÖN KOŞUL** | Saracıye tasarım ve kalıp modüllerini bilgisayarda çizim modülü almuş olmak.  
**YETERLİK** | Saracıye Modelistliği ile ilgili Mesleki İngilizceyi Kullanmak  
**MODÜLÜN AMACI** | **Modül Amacı**  
| **Genel Amac**  
| Gereklı ortam sağlandığında; saracıye modelistliği ile ilgili mesleki İngilizceyi okuma anlama, yazma ve konuşma düzeyinde öğrenebilecektir.  
| **Amaçlar**  
| 1. Saracıye tasarım  
| 2. Saracıye ürün kalıbı çıkarma  
| 3. Bilgisayarlı modelllemeye kullanılan çizim komutlarını İngilizce okuma, anlama, yazma ve konuşma düzeyinde öğrenebilecektir.  
**EĞİTİMÖĞRETİM ORTAMLARI VE DONANIMLARI** | Tasarım odası, kalıp çıkarma şififi ve el aletleri, bilgisayar laboratuarı, bilgisayar, tarayıcı, yazıcı, saracıye çizim programı vb.  
**ÖZLEME VE DEĞERLENDİRME** | Her faaliyet sonrasında o faaliyette ilgili evet-hayır, doğru-yanlış şeklindeki sorularla kendi kendiniizi değerlendireceksiniz.  
| Modül sonunda uygulanacak ölçüme araçları ile modül uygulamalarında kazandığınız bilgi ve beceriler ölçülerek değerlendirilecektir.
Dear student;

Design is one of the most important issue in saddlery production. To have the good quality; materials, design and production should be considered as a whole.

It is essential to give importance to design as a leather goods sector in order to take part in domestic and international markets. As well as hand-made design, computer-aided design is also made thanks to the latest technology.

Pattern is generally extracted by hand, however this work is time consuming and requires experience. Therefore big firms make these product patterns via computer technology designed for this purpose.

In this module, it is aimed to teach design, pattern and drawing on computer by speaking and reading in English.
LEARNING ACTIVITY-1

AIM

In this activity, you will be able to use professional English related to saddlery design.

SEARCH

Before this activity, you are supposed to do previous research for the following issues;

- 1- Examine magazine and catalogues related to leather goods.
- 2- Arrange meetings with the people on this sector. Take notes on the things require attention.
- 3- Memorize the words related to technical drawing.
- 4- Share the necessary information with your friends and teachers.

1. SADDLERY DESIGN

1.1. Basic definitions and terms used in the design of saddlery

1.1.1. Design

Design is defined as formatting, envisioning and imagining in the mind.

It is the appearence of a product in terms of line, shape, color, form and texture which can be perceived by human senses. The glass you hold, the computer you use, the pencil you use to write, the chair you sit and everything you see is the work of design. The main aim of the design is make the things more practical for people to use. For this reason; designer, reflects and transfer his/her emotions, thoughts, imagination via physical phenomena like lines, shapes, colors.
1.1.2. Saddlery Fashion

Leathergoods sector is a field with wide variety of models and product range and it constantly changes according to the needs and fashion trends. The first stage of leathergoods production starts with the designing phase conducting by the designer in or out of the firm. The choice of material is of great importance for saddlery design. The things that should be taken into consideration here is the suitability of materials and design with each other. In saddlery raw material, design, production method are in close relation with each other since this stage starts with the idea of the emergence and the visualization of the product which is appropriate for daily trends, the rationale of the firm and existing production capacity.

1.1.3. Basic Elements of Design

Basic elements of design are the same in all branches of art. Seeing and figure-ground connection is important in design. The following points should be considered during design.

1.1.3.1. Elements of Design

- point
- line
- direction
- shape
- size
- value range
- texture
- color

1.1.3.2. Principles of design

- repetition
- conformity
- contrast
- theory
- unity
- domination
- balance

1.1.4. Products of Saddlery

Leather products are considered to be classified as follows;

Many leather goods, except clothing and footwear, are considered as saddlery products. The main ones are,
Travel bags, sports bags and suitcases
School bags, brief cases
Handbags, wallets
Purses, pocketbooks
Handbags with or without hanger
Musical instrument boxes
Jewellery box and boxes for valuable articles and devices
Waist belt and watch straps
Harness and collars
Hunting and sports equipment
Office requisites, pad sets, file holders, penholders, notepads, blank books
souvenirs, ornaments and so on.

1.1.5. Raw materials used in saddlery

- Leather
- leatherette
- Impertex
- Acetate (transparent nylon)
- Various kinds of fabric (denim, linen, filet etc.)

1.1.6. Types of primers used in saddlery

- Vinlex
- Fabric lining (Pamuk, saten, naylon)
- Fiber
- Sponge
- Polyester
- Parachute cloth
1.1.7 Supplementary materials

- Yarns;
- Velcro strips;
- Zipper;
- Accessories rings (Plastic and metal buckles);
- Hobnail: A kind of metal or plastic ridge used in hand-making to protect bags from getting dirty;
- Torque: it is in various sizes and used for combining, pomel (handle), suspension, and decoration;
- Swivel: it is used for backpack hanger installation, assembling columns, closing the mouth of pockets and for ornamentation. It is made of metal and plastic in various colors.

1.1.8 Hardening materials

- Cardboard
- Buckram
- Sponge
- Salpa
- Fiber
- Pead
- Teksoxson paper, butcher paper, etc.

1.2 Classification of saddlery design

In saddlery products, certain items are classified in itself. Such as bag, belt wallet.

- According to fashion; trend colors and lines of the year.
- According to gender; school bags, woman and men’ bags
- According to the place of use; Sports bags, elegant bags.
1.3. The main points of the design

1.3.1. Parts of a wallet

Photograph 1.2:

- body
- middle piece
- card holder
- right and left cue
- spacer
- Binding

1.3.2. Parts of a waistband

Photograph 1.3: Parts of a waistband

- body
- bolt of a lock
- bridge
- clasp
- fastener
1.3.3. Parts of a bag

Generally women’s bags model patterns consists of the following parts:

- **Front and rear body**: it is the basic part of the bag which forms front and back surfaces.
- **Below**: it is the part that gives volume to the bag.
- **Bottom-floor**: it is the bottom part of the bag.
- **Handle**: it is used for carrying and holding the bag.
- **Lining**: it is the inner cover of the bag.
- **The inlet of the bag**: it is the mold part of the bag which is used for determining the inlet body curve.
- **The medium section of the bag**: it is the inner chambers of the bag.
- **Hardening pattern**: it is the part which gives volume and stiffness to the bag.
- **Molds**: it is the mold patterns of the bag.
- **Handle model**: it is the piece of a pattern molding without the edge part of a handle.
1.4. Designing bag and waistband

First of all, a research should be done on the designed product. Within the scope of the work, after obtaining general information by examining the similar products that are produced before, users’ views should be collected. You should identify possible problems since you may encounter and pay attention to these problems during design. After a detailed investigation, you should focus on the product with the compiled information gathered. A brainstorming could be done with the related people to produce new ideas.

Sketchbook work should be started. But before starting, the emergence stages of the product should be known.

The emergence of the product starting from the design process of the saddlery are as follows:

- The starting point of an idea; for example, a leather fabric combination or a sports bag for women which takes lots of goods.
- The starting point of production; a bag design which presents the natural appearance of the leather, and sporty effect of the fabric.
- Defining the target audience; for example; to 35 years of age
- The development of an idea on a product; it could be hand-made or computer-drawing depending on the designer’s working style.
- The choice of material; a material which reflects the quality of the product and which is easy to find and produce should be determined beforehand. Then, sample leather which is fashionable and appropriate for the style of the bag is chosen. In order to make the bag stronger and enduring, lining fabric and accessories which are appropriate for the leather color is chosen and then production stages should be revised. As a next step, sketchbook work is started and forms of measurement models should be prepared along with the design and if needed, a prototype of the product is prepared and presented.
1.4.1 Design of a bag

Photograph 1.4: Alligator skin

Drawing 1.1: Design drawings

Drawing 1.2: Design drawings

Drawing 1.3: Design drawings
1.4.2. Design of a belt

Drawing 1.4: Drawing of a man’s belt

Drawing 1.5: Sketchbook work

Drawing 1.6: Design of a belt
MEASURING FORM IN TERMS OF MODELS

Men’s Belt

Model of classic men’s belt whose production is determined is drawn in detail. (Last step of the design)

When one prepares model form, sample for classic belt is examined and its characteristic features are determined. If a change on the product is required, it is determined.

- Determining features of leather type
- Dividing the belt into parts and naming it
- Determining width and height measure of the belt
- Determining techniques which will be applied in its fabrication
- Determining stitch size and type
- Determining its stuffing material which will be used
- Determining buckle type and its size which will be used

Taking your determinations you have made into consideration, one will supply instruments which will be used. Parts of the belt are extracted separately.

Information about Production

Production flow and segments of the belt whose design will be applied are supposed to be found.

- **Forming size pattern**: Makin a mould with materials like parchment, moulage, cloth or imitated leather and so on.
- **Preparing prototype**: It is required for the original materials which will be used in the design to be chosen and to be turned into the product.

One is supposed to prepare a model information form of the product whose production will be done.

Calculating the Cost

- **One calculates cost of the product**: The cost of materials used, technique, workers and so on.
- **Work for determining the price**: One searches for prices of products whose duplicates take place in the market. Design process of the product is finished.
APPLICATION ACTIVITY

Instruments which will be applied

- Work table
- Lead pencil
- Moulage paper
- Ruler
- Eraser
- Magazines and catalogues
- Turkish-English dictionary

Taking process steps and matters which are stated in the recommendations into consideration, make a bag design. Prepare a model measure form.

<table>
<thead>
<tr>
<th>Steps Of Process</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze English bag model catalogues.</td>
<td>Read magazines and catalogues</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Learn Turkish equivalents of English words</td>
<td>Use a dictionary about unknown words</td>
</tr>
<tr>
<td>used in the catalogue and design.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Make sketch studies.</td>
<td>Pay attention to material choice and its conformity for</td>
</tr>
<tr>
<td></td>
<td>production in the sketch studies.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Make your design.</td>
<td>Draw images of each part of the design.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Prepare model measure form.</td>
<td>Pay attention to rate-proportion.</td>
</tr>
</tbody>
</table>

EVALUATION

Compare your answers with the answer key and evaluate yourself by stating your true answers’ number. Repeat the subjects related to the subjects you answered false. If you are successful, then go on with practicing test.
CHECKLIST

If you have behaviors listed below, put (X) in “Yes” box for earned your the skills within the scope of this activity otherwise put (X) in “No” box.

<table>
<thead>
<tr>
<th>Evaluation Criteria</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Have you analzed leathercraft catalogue written in English by taking it?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Have you learnt Turkish equivalent of English words used in the design?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Have you made sketch study by integrating your observations with your creativity?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Have you drawn each part’s image?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Have you prepared model measure form?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVALUATION

Please review your "No" answers in the form at the end of evaluation. If you do not see enough yourself, be repeat learning activity. If you give all your answers "Yes" to all questions, pass to the "Measuring and Evaluation".
Assess what you have learnt in this activity by answering the questions given below.

Evaluate the answers of the questions given below as true (T) or false (F).

1. ( ) Harness and saddler are among leathercraft products.
2. ( ) Hobnail is an apparatus for raising metal.
3. ( ) Slack is a type of interlining.
4. ( ) Buckle is a part of the belt.
5. ( ) Another name of bellow is instrumentation.
AIM

You can use professional English related to moulds in leathercraft products with this activity.

SEARCH

Primary researches you should make before this activity are:

- 1-Search for instruments used in making mould.
- 2-Get information about marks used on the mould.
- 3-Observe works of a master who makes moulds of leathercraft products.

Share information you have gotten.

2. LEATHER CRAFT MOULD

Mould prepared by being measured with steel ruler according to model measure form is made on carton. Marking is done with lead pencil. After you are sure about accuracy of mould, the mould which will be placed on leather is cut from paperboard.

These instruments are used in mould process:

- Scissors
- Leather cutting knife
- Caliper gage,
- Compass
- Steel ruler
- Ruler with calibration
- File
- Paddle staple
- Awl
- Tongue staple
- Rubber
- Silver pen
- Hummer etc.
2.1. Techniques for making mould

There are two ways for making mould.

- One makes mould by getting exact measures over ready model and transferring them to carton.
- One makes mould with measures obtained with ratio proportion method over picture.

2.1.1. Get mark in the mould

Marks on the mould have roles as guiding spirits in cutting and production. Width and height lines are among the portions which should be added to the measure when one makes model mould. These portions are the ones where curling and stitching portions are instrumentation and put on each other when model mould is prepared. These portions are marked on model mould.

The product is measured without portions. When making model mould, one addes measure portions to this product. Measure portions change according to the product and features of models. Approximately measure portion standard used in making bag are those:

- Portions for stitching : 0,4-0,5 mm.
- Portions for curling : 0,7-0,5 mm.
- Portions for mounting: 0.7-0.8 mm.
- Portions for instrumentation: 0.3 mm

See geometrical drawings – making appearance module

**Important Points in Preparing Mould**

- One should add portions for mounting, stitching and curling to model moulds.
- One should pay attention to milimetrically measurement when adding portions.
- One should prepare moulds as half mould by taking mould symmetry.
- One should take symmetries of moulds by folding them.
- In order to cut, one should pay attention to sharpness of the knife.
- One should pay attention to matching of measures of moulds.
- One should not forget to place product information marks on moulds.
- One first should prepare moulds from model carton.
- One should show middle mark and portion places on each mould.
- If there is a rough resulting from cutting sides of moulds, one should softly rub them with a thin rubber.

2.1.2. Making carton moulds

In line with information taking place on model measure form resulting from model design period, first of all mould is made on a carton. After being sure about it, one makes its mould from a carton.

2.2. Mould parts

Prepared model measure form also shows parts and number of the product.

- Bag Design

There is no standard measure in women’s bag. After one determines bag parts whose measures will be taken, parts are measured.

One starts measuring with most clear part of the bag. When measuring, one should be very careful. Feeding and hardening parts and internal option parts (liner, middle division etc.) are measured according to leather surface moulds. Measuring these parts is done after external surface moulds are prepared. Part which should be measured first is body model which is the clearest part of the bag. Width and height measures of front and back body are taken with ruler with calibration without portions. Portions which should be added to the bag are added when one makes model mould.

All parts on the bag are designed respectively.
**MEASURE FORM ACCORDING TO MODEL**

<table>
<thead>
<tr>
<th>Model mould part name</th>
<th>Width</th>
<th>Height</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body (Front and back)</td>
<td>31-33 cm</td>
<td>14-17 cm</td>
<td>2</td>
</tr>
<tr>
<td>Souffle (Bellow)</td>
<td>2,5-9 cm</td>
<td>15 cm</td>
<td>2</td>
</tr>
<tr>
<td>Bottom leather model</td>
<td>33 cm</td>
<td>13,5-10 cm</td>
<td>1</td>
</tr>
<tr>
<td>Stipe leather model</td>
<td>5 cm</td>
<td>60 cm</td>
<td>2</td>
</tr>
<tr>
<td>Stipe assembly model</td>
<td>31-33 cm</td>
<td>14-17 cm</td>
<td>-</td>
</tr>
<tr>
<td>Painting and marking zip</td>
<td>4 cm</td>
<td>42 cm</td>
<td>-</td>
</tr>
<tr>
<td>Interior body liner model</td>
<td>40,5-33 cm</td>
<td>20,5-16 cm</td>
<td>1</td>
</tr>
<tr>
<td>Bottom feeding</td>
<td>34 cm</td>
<td>13,5-10 cm</td>
<td>1</td>
</tr>
<tr>
<td>Stipe leather instrumentation</td>
<td>5 cm</td>
<td>50 cm</td>
<td>-</td>
</tr>
<tr>
<td>Liner mouth carton mould</td>
<td>37-30 cm</td>
<td>2,5-2 cm</td>
<td>1</td>
</tr>
<tr>
<td>Bottom hardening</td>
<td>6,5 cm</td>
<td>32 cm</td>
<td>1</td>
</tr>
<tr>
<td>Drawing body mouth</td>
<td>31-33 cm</td>
<td>14-17 cm</td>
<td>-</td>
</tr>
<tr>
<td>Interior middle division liner</td>
<td>25-33 cm</td>
<td>14 cm</td>
<td>2</td>
</tr>
<tr>
<td>Rib leather</td>
<td>1.8 cm.</td>
<td>41 cm.</td>
<td>2</td>
</tr>
<tr>
<td>Stipe tip lower leather</td>
<td>5 cm</td>
<td>7 cm</td>
<td>4</td>
</tr>
<tr>
<td>Stipe tip rib covering model</td>
<td>3,5 cm</td>
<td>6 cm</td>
<td>2</td>
</tr>
</tbody>
</table>

**Table 2.1 : Model measure form**

- **Front and back body model**

Mesasures used in making body model mould are the ones in model measure form.

In order to make body model of the bag, one gets benefit from width and height measures of the body. Measures prepared in model measure form are transferred to model carton.

Portions (stitching, curling, mounting portions) are added on moulds.

- One folds ½ of the mould.
- One extracts all mould by taking its symmetry. One writes uniting and information marks on mould.
- One marks middle line of body mould. The middle line is determined by softly being drawn with cutting knife. rta çizgisi işaretlenir.
- Mould prepared from model carton is transferred to cutting carton.
Model for drawing body mouth

In order to make mould for body mouth, one uses body mould. Body mouth curling portion is extracted and the mould is drawn without portion. One writes information marks on the mould which is taken on model carton and cut. Its middle line is determined.
Bottom Leather Model

It is the model mould for bottom sitting part of the bag. It gives bag width and place. One draws shape and width by getting benefit from bottom leather model body mould. As in all moulds, one makes its drawing as ½.

Bottom Hardening Model

In order bag to sit, one makes hardening on its bottom.
When preparing the mould, one gets benefit from body and bellow model moulds. It is made from hardening material (carton). For bottom hardening mould length measure, one takes width of body model mould by extracting stitching portion. In its width one takes bottom width of bellow mould. One extracts bottom hardening mould which has a rectangular form by drawing measures on model carton. Middle marks are done by softly cutting with a cutting knife.

Photograph 2.6: Bottom hardening model

➢ Bottom Feeding Model

In order to support the bag bottom, it is the model performed from feeding material. It is prepared from model carton by decreasing curling blade portions from prepared bottom leather model (curling blade portion 0.4 mm.) It is transferred to cutting carton by taking its middle marks.

Photograph 2.7: Bottom feeding model
- **Stringer and marking zip model**

Model for stringer and marking zip model helps us place zip. By taking more than a few cm from the length of measured zip, one draws it on model carton. One marks zip length, zip’s hanging portion, adhesive version portion on the mould prepared in a rectangular shape. One takes its middle marks. One cannot make leather cut from this mould. One can only use this in zip assembly.

![Photograph 2.8: Model for zip stringer and marking](image)

- **Bellow Mould Measures**

Bellow measures are transferred to model carton by getting benefit from model measure form. One draws half of bellow mould and cuts. One takes its symmetry by folding it into two. Then one makes its symmetric cut. One transfers necessary uniting and information marks (rib start and finish, turning corner, middle mark) on bellow mould.

![Photograph 2.9: Bellow Model](image)
Preparing body liner model

In order to extract liner mould, one should prepare body, bottom and bellow moulds of the bag. Liner moulds are prepared by minimizing their leather moulds in 2,5 mm. from their four sides.

Body mould is drawn on model carton. Bottom model mould is folded in two in its width. One draws it as its oval part will come under the body. Bellow mould is folded in two from its height. Bellow folded adjacent is drawn in side of the drawn liner. It is drawn as its bottom will be 90 degree (Picture 4.1). One adds 4 mm stitching portion to liner mould prepared by minimizing 2,5 mm. from body moulds. After one writes uniting and information marks, one cuts liner mould.

Photograph 2.10: corner drawing

Photograph 2.11: body liner model
Preparing interior division liner model

In order to extract middle division liner mould, one uses body, bottom leather and body model moulds. Width of its lower part is taken with bottom leather mould width. Its mouth width is taken smaller than body model mouth width (2 cm from each two edges). One cuts liner moulds by giving 4 mm. stitching portions to liner moulds prepared according to measures. Uniting and information marks are written on moulds.

![Photograph 2.12: Interior middle division liner model](image1)

- **Liner mouth carton mould**

It is the carton mould used for hardening liner mouth. One cannot make leather cut from this mould. It is taken from body liner mould. Body mouth part is drawn on model carton. Its width is cut from 2.5 cm. Height is taken same. One writes information marks on it.

![Photograph 2.13: Liner mouth carton mould](image2)

- **Preparing stipe leather model**

Measures which are ready in measure form are transferred to mould. One draws and cuts by adding instrumentation portion (3mm) to height and width measures. Production information is written on the model. When making stipe leather cut, one cuts by adding stipe tip lower leather mould.

24
Stipe tip lower leather and slack model

One prepares stipe tip model by getting benefit from stipe leather model. Its width is taken same with stipe mould. According to its model features, its tip part can be prepared in shapes like round, rectangular, triangle etc. One gives indent into start point of rib as it is not seen. This mould is added to the tip of stipe leather mould and it is used in cutting stipe, stipe tip leather cutting and feeding materials (slack) cutting. These moulds are also used in stipe leather instrumentation and preparing model mould.

Stipe leather instrumentation model

One adds 2.5 – 3 mm. instrumentation portion to model of work part which will be instrumented. Instrumentation mould is prepared by extracting these portions.

Stipe leather instrumentation model is prepared by uniting stipe leather and stipe tip models. Stipe leather is drawn on model carton as ½. One places stipe tip model at the tip of it and draws. Instrumentation portion (2.5 – 3mm) is extracted from the drawn model. One takes symmetry of the mould drawn on model carton in ½ ratios by folding and cuts. One cannot make leather cut from stipe instrumentation model.
Leather model covering stipe tip rib

It is the model used for covering rib tips which will be placed in stipes. Its width is taken as it covers the rib according to width of rib (5-6 cm). One draws 0.5 cm bias from two edges in order tip points not to make thickening. Mould prepared on model carton is cut and its cutting information is written on it.
- **Stipe Assembly Model**

It is prepared to determine the place where the stipe will be assembled to the bag. This mould makes right assembly of the stipe on the bag possible. One cannot make leather cut from the stipe assembly mould.

One gets benefit from body model mould in order to extract stipe assembly model. Body mould is written on model carton. One makes mouth curling (0.4mm). The place for stipe assembly is determined as appropriate for the model. By putting stipe tip model on stipe assembly model, one draws stipe assembly place and cuts. One also cuts edges of the mould and folds it two from the middle mark. One makes its symmetric drawing and cutting at the other side of it (Photograph 2.19). Therefore, its stipe places are determined equally.

It is prepared for determining the place where stipe will be assembled to the bag.

![Photograph 2.19: Symmetric cut by folding](image)

![Photograph 2.20: Stipe assembly model](image)
2.3. Mould Types

2.3.1. Belt Mould

One piece belt mould

Extracting stamp for edge

Appropriate carton for measure which will be worked is cut. Width of the band whose tip will be made is measured with compass.

![Photograph 2.21: Taking width measure of the band](image)

One takes middle mark without pressing cutting knife too much (without cutting the carton) on half of the carton.

![Photograph 2.22: Taking middle mark on carton](image)

It is folded two from the marked palce in order to make symmetric drawing (Photograph 2.22).
Intended tip length (e.g. 4.5 cm) is measured from the tip of carton and marked. Half measure of the band is marked to half measure of the carton. (If it is 4cm, it is marked as 2cm) One cuts from the marked half measure (2cm). One draws half of the intended tip shape with the help of any materials (mitre, anglemeter, etc.). It is cut on the line (Photograph 2.24, 2.25).
Roughs of the cut part are taken with a thin rubber. Hold the rubber with 90 degree angle (Photograph 2.26). Control with your forefinger if roughs disappear or not.
One makes tip cut knife if it is used in serial production. When making somebody make knife, the mould should be perfect because knife will be as what the mould like.

- **Extracting stamp of waist adjustment holes**

According to model features, one pays attention to largeness of buckle latch which will easily enter and exit tip of the belt. Generally, the number of holes in women’s belts with 5 models (Sport, classic belts) can be 1, 2, 3, etc or more or less. (Photograph 2.29-2.3). In serial production, holes are opened with puncher set on three head machine. Spaces between holes is generally made as 2.5 cm.

If one opens tip and holes of the belt in manual, one makes the same tip and waist adjustment holes on stamp. Moreover, one cannot extract another stamp for waist adjustment holes.

In order to prepare stamp of waist adjustment holes, carton which has the same width and height measures (eg: 4 cm in width, 30 cm in height) with the would-be belt is cut (Photograph 2.31).
One can work on intended tip shape on this carton piece. (Photograph 2.32)(See Extracting tip stamp) One finds half of the carton and draws there with a straight line or dashes (Photograph 2.33).

One marks 15 cm from the tip of the belt. This place will be the hole which is the middle of the five holes. One makes marks two more for the right of middle hole and two more for the left of middle hole. Therefore, one can make 5 holes places. There will stay a 10 cm space in the tip of the belt (Photograph 2.34). Spaces between the holes can be increased or decreased if required.
In order to open to intended point without sliding wais adjustment holes, one gets help from the round behind the ruler and so can take it into the round with mark from the centre (Photograph 2.35).
One makes holes in these rounds when puncher is enough big by bringing it into intended age and rounds can be pierced (Photograph 2.36). This prepared mould (stamp) is placed at the tip of the band which is cut and is transferred to the leather by drawing with leather drawing pencil (Photograph 2.37).

![Photograph 2.36: Making holes with puncher with wheel](image)

![Photograph 2.37: Transferred holes to leather](image)

In serial production, waist adjustment holes are opened in three heads machine. Perforating capsules on perforating mould. If required one can change apparatus and spaces between the holes.

- **Extracting buckle stamp**

  It is the part where buckle of the belt is placed. If cut of this part is made in machine as in other parts, there is no need for a buckle mould. If one makes handmade cut, in order to determine places for buckle and puncher, one requires extract a buckle mould.

  In order to extract buckle mould, prepare a piece of carton (4x 15cm ) which is appropriate for measure you will cut. One takes half measure mark on the carton (without pressing cutting knife too much) (Photograph 2.38).

![Photograph 2.38: Making half measure mark on the carton](image)
One fold the carton two and draws the intended shape or a round thing with a measuring material on a tip of the carton. (Photograph 2.39).

Cut carefully during the line. When drawing in the course of cutting, get help from a thing or ruler, this will provide you with straighter cutting (Photograph 2.40).

Make a mark for place for latch by indexing (generally 5cm) in the intended measures into buckle mould (Photograph 2.42)
Perforate with a latch puncher in appropriate largeness from the marked places without sliding them. Apply a latch puncher which enables buckle latch to enter and exit easily (Photograph 2.43-2.44). standard for place for latch is 2 cm. Note: Make perforating process on a thick rubber fabric.
Buckle mould (stamp) which is extracted is placed on top of the edge of leather band and one cuts it with cutting knife (Photograph 2.45). one draws places of latches with leather drawing pen without lifting stamp (Photograph 2.46). Stamp is perforated with latch puncher (Photograph 2.47). In serial production one makes cutting buckle place and opening place for latch with buckle knife (Photograph 2.48-2.49).

Extracting bridge mould

In order to in match with edge of belt, it is used. It is placed in the buckle part. Its height is measured according to width of the belt. Width of the bridge is generally 1may be 1,5-2 -2,5 cm. According to the features of model, it is made from leather which is used in the body of belt. One can use bridge according to the model. With the buckle one can immobilize the bridge. If required, the bridge can be prepared in one or two parts. In serial production, especially in classical belts, bridges are prepared from the leather bands which are cut in leather band cutting machine. For that, one does not extract bridge stamp. Sport belt bridges are cut with cutting knives prepared as pairs in cutting press. In order to make somebody do cutting knife of make cutting bridge in handmade, it requires to extract bridge mould (stamp).
Take a carton appropriate for measures which will be used in cutting and cut the intended width (1.5 cm) of bridge on the carton by marking it (Photograph 2.50 - 2.51).

In order to adjust height of the bridge, fold the belt two. Hold paper band as coming each other’s edges by weaving it to the belt which is folded two and mark the place where the other edge finishes (Photograph 2.52 - 2.53). Cut starting from the marked place. Therefore, one can extract bridge mould (stamp).
2.3.2. Wallet moulds

According to the features of model, parts of the wallet can change. There are measure standard which do not change according to men, women or model features. These are banknote (money) measures and credit card measures. One adds 1-2 mm to the model or if required as easily entering and exiting portion.

MEASURE FORM ACCORDING TO MODEL

<table>
<thead>
<tr>
<th>Model mould part name</th>
<th>Width</th>
<th>Height</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>body</td>
<td>27-28 cm</td>
<td>12-13cm</td>
<td>1</td>
</tr>
<tr>
<td>Middle piece</td>
<td>25 cm</td>
<td>10-11cm</td>
<td>1</td>
</tr>
<tr>
<td>Body liner</td>
<td>25-26 cm</td>
<td>10-11cm</td>
<td>1</td>
</tr>
<tr>
<td>Place for cards</td>
<td>10-11cm</td>
<td>8-9 cm</td>
<td>2</td>
</tr>
<tr>
<td>Middle place for cards and its liner</td>
<td>9-10 cm</td>
<td>7-8 cm</td>
<td>2</td>
</tr>
<tr>
<td>Pocket liner for place for cards</td>
<td>10-11 cm</td>
<td>7-8cm</td>
<td>2</td>
</tr>
<tr>
<td>Liner for covering places for cards</td>
<td>9-10cm</td>
<td>7-8 cm</td>
<td>2</td>
</tr>
<tr>
<td>Right and left souffle</td>
<td>7-8 cm</td>
<td>2 cm</td>
<td>1</td>
</tr>
<tr>
<td>Interface piece</td>
<td>3-4 cm</td>
<td>10-11 cm</td>
<td>2</td>
</tr>
<tr>
<td>Binding</td>
<td>24-25 cm</td>
<td>1-2 cm</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 2.2: Model measure form

When measuring main body, one starts from outer parts of the body. Measuring process is done with tape measure. As being different from other parts, main body measure is made when the wallet is semi-open because of stretch portion (Photograph 1.3). Height of the wallet is taken with the help of tape measure vertically. Other parts of it are measured as appropriate for measure of main body.
One starts extracting wallet mould from the main body. One extract mould as appropriate for measures in measure form. Firstly, leather surface moulds are prepared. Interior part moulds are prepared as appropriate for outer surface moulds.

27-28 CM
Drawing: 2.2. right soufflé mould

Drawing: 2.3. left soufflé mould

Drawing: 2.4. binding mould
Drawing: 2.5. main body liner mould

Drawing: 2.6. mould for middle place of cards
Drawing: 2.7. pocket liner mould for place of cards

Drawing: 2.8. mould for middle liner middle part

Drawing: 2.9. back liner mould for middle place of cards
Drawing 2.10. middle liner mould

Drawing 2.11. right and left place of cards mould
2.3.4. Moulds of small products

Keyholder with hook

There is no standard measure in keyholder with hook. When measuring, one pays attention to width of the hook which will be added to the keyholder. Middle part is measured as appropriate for width of the hook. Again as appropriate for width of the hook, one takes measures of other parts. Measures are taken without portions.

Keyholder with hook is formed with three parts as body, lateral part and middle part. Besides these, one uses materials for making liner and feeding. Measuring these is made according to leather moulds. By taking portions from leather moulds, one measures feeding and liner parts. When measuring, one pays attention to matching of part measures.

Photograph 2.58

Measures without portions of the product are given in model measure table. Portions are added to the mould when mould is prepared.

MEASURE FORM ACCORDING TO THE MODEL

<table>
<thead>
<tr>
<th>Part name of keyholder mould</th>
<th>Width</th>
<th>Height</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Body</td>
<td>10,5cm</td>
<td>20 cm</td>
<td>1</td>
</tr>
<tr>
<td>Lateral parts</td>
<td>6 cm</td>
<td>10,5 cm</td>
<td>2</td>
</tr>
<tr>
<td>Middle part</td>
<td>6,5 cm</td>
<td>10,5 cm</td>
<td>1</td>
</tr>
</tbody>
</table>

Table 1.1: keyholder measure form

Keyholder model moulds are prepared as appropriate for measures written in measure table.
**Body Mould**

Body is basic part forming keyholder with hook. Body forms with a part. Measures given in measure form are applied on carton. Curling portions are added (0.5 cm) and drawn. One cuts it with the help of ruler. As appropriate for width of hook, gripper part is determined and perforated. Information marks are added on it.

**Middle part mould**

Measures given in measure form are applied on carton. Curling portions (0.5 cm) are added to two sides of long parts. Hook whose keyholder will be added is put on the mould and its holes places for hook are marked. One makes mould cutting from the carton. By writing information marks, one perforates holes with puncher with wheel.

**Lateral part mould**

Lateral part measures in measure form are applied to model carton. Curling portion with one side (0.5 cm) is added to the long part of the mould. Curling portion is marked and cut. Perforating place of the mould which is cut is marked and perforated. One makes two leather cutting from this part. One only opens gripper hole in left part in leather cut.

All leather parts of keyholder with hook are prepared from cutting carton and it becomes ready for leather cutting. (Drawing 1.1)
Liner mould

Liner mould is prepared by extracting portions from leather moulds. Liners are made for all leather parts except from the middle part. Body leather mould is drawn on the carton. One draws it by extracting curling portion (0.5cm). Mould whose drawing is made becomes ready by being cut with the help of ruler.

Hardening Mould

Anchor aweigh is used as a hardening material. Hardening is just applied on the centre piece leather. Hardening material mould is made removing the curling portion of the middle part.
Tools and Materials To Be Used (see loom operations mod.)

- Drafting board
- Cutting table or cutting plastic
- Lead pencils
- Cutting knife
- Sharpening steel
- File
- Cutting board
- Model board
- Steel rule
- Model measuring form

Make body model moulds taking into consideration process steps and points stated in the suggestions.

<table>
<thead>
<tr>
<th>Process Steps</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharpen the cutting knife keen and sharp</td>
<td>Make a sensitive measurement</td>
</tr>
<tr>
<td>Apply the body measurements on the model board.</td>
<td>Make sure that the cutting knife is keen and sharp.</td>
</tr>
<tr>
<td>Draw the model befitting model and measurement.</td>
<td>Check the yardsticks for the moulds to match with each other.</td>
</tr>
<tr>
<td>Add the portions</td>
<td>Boards can be easily folded if the folding part is drawn gently with the end of cutting knife to get the symmetry of moulds.</td>
</tr>
<tr>
<td>Make the body model in the size of 1/2</td>
<td>Make the width measurement of the bottom leather model mould to be compatible with the down part of the body.</td>
</tr>
<tr>
<td>Apply cutting by folding the mould in half and getting the symmetry.</td>
<td>Remove the curling portion of the body model while making the body mouth model mould.</td>
</tr>
<tr>
<td>Apply the necessary combining and informatory sign on the mould.</td>
<td>Transfer the combining and informatory signs carefully.</td>
</tr>
<tr>
<td>Make a width measurement and shape of the bottom leather model mould in accordance with the down part of the body mould.</td>
<td>Be careful about the risks of the cutting knife.</td>
</tr>
<tr>
<td>Draw the same model of body mouth drawing putting it on the body model mould and apply cutting removing the mouth curling portion.</td>
<td>Use a steel rule for the straight cutting.</td>
</tr>
<tr>
<td>Step</td>
<td>Instructions</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>➢</td>
<td>Transfer the informatory signs of all body moulds to it.</td>
</tr>
<tr>
<td>➢</td>
<td>Never forget that the mould can affect the model directly.</td>
</tr>
<tr>
<td>➢</td>
<td>Cut the moulds out of the model board.</td>
</tr>
<tr>
<td>➢</td>
<td>While preparing the bottom hardening mould do not forget to remove the stitching portions from the width of body mould.</td>
</tr>
<tr>
<td>➢</td>
<td>Transfer the leather cutting moulds to the cutting moulds.</td>
</tr>
<tr>
<td>➢</td>
<td>Make a careful measurement while adding the portions to the measure.</td>
</tr>
<tr>
<td>➢</td>
<td>Make the measurements of blower down base and body width for the mould of bottom hardening model and remove the stitching portions from the body width.</td>
</tr>
<tr>
<td>➢</td>
<td>Carry out the cutting on the cutting plastic.</td>
</tr>
<tr>
<td>➢</td>
<td>Transfer the product informatory signs on the cutting board.</td>
</tr>
<tr>
<td>➢</td>
<td>Rub down without compressing.</td>
</tr>
<tr>
<td>➢</td>
<td>Rub down the edges of mould with fine-grained emery if they are rough.</td>
</tr>
<tr>
<td>➢</td>
<td>Be careful while transferring the signs to the zip stringer and marking mould.</td>
</tr>
<tr>
<td>➢</td>
<td>Make a bottom supply model in the same size by diminishing the curling shaving portion of the bottom leather model.</td>
</tr>
<tr>
<td>➢</td>
<td>Make sure that the emery is fine-grained.</td>
</tr>
<tr>
<td>➢</td>
<td>Determine the zip measure for the model of zip stringer and marking measuring it more than it is.</td>
</tr>
<tr>
<td>➢</td>
<td>Never forget that millimetric mistakes can affect the mould in a negative way.</td>
</tr>
<tr>
<td>➢</td>
<td>Measure the width of zip stringer to be as large as zip width.</td>
</tr>
<tr>
<td>➢</td>
<td>Draw it on the model board and then cut and mark the sag portion, adhesive portion and zip length on it.</td>
</tr>
</tbody>
</table>
Assess what you have learnt at the end of this activity by answering the questions below.

Mark the answers of the questions below as true or false

1. ( ) Leather cutting cannot be made from the bottom hardening mould
2. ( ) Leather cutting is made on the model board
3. ( ) Stitching portions are added to the zip stringer mould.
4. ( ) Body mouth drawing model is used to determine the curling place of body mouth
5. ( ) The measures of the moulds are prepared without matching.
6. ( ) Bottom hardening mould is designed according to the handle measures
7. ( ) Portions are not added while making moulds.
8. ( ) The body of the bag is embellished by use of several techniques.

EVALUATION

Compare your answers with the answer keys and evaluate yourself by determining the number of correct answers. Revise the learning activities as to the subjects to which you have given wrong answers. Pass to the application test if all the answers are correct.
PERFORMANCE EVALUATION

If you have not observed the behaviors listed below mark (X) under NO but if you have observed the behaviors in question mark (X) under YES

<table>
<thead>
<tr>
<th>Evaluation Criteria</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Have you sharpened the cutting knife keen and sharp?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Have you transferred the body measures to the model board?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Have you drawn the mould in accordance with model and measurement?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Have you added the portions?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Have you made the model mould in the size of ½</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Have you got the symmetry by folding the mould in half?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Have you transferred the necessary combining and informatory signs to the mould?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Have you made the width and shape of bottom leather model mould in accordance with body mould?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Have you prepared the body drawing mould removing mouth curling portion from the body model mould?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Have you cut the moulds out of model board?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. Have you transferred the moulds to the cutting board for leather cutting?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. Have you transferred the product information and signs on the cutting board?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. Have you leveled the edges of board moulds with the emery?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14. Have you prepared the bottom hardening mould in accordance with the measures of blower down base and width?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15. Have you drawn by removing the stitching portions from body width?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16. Have you cut the bottom hardening mould out of model board?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17. Have you made use of bottom leather model mould and removed the curling shaving portion while preparing bottom supply model?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18. Have you measured the length of zip stringer mould more than the zip length?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19. Have you measured the zip stringer mould as large as zip width?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20. Have you transferred the sag portion, adhesive and zip length signs on the zip stringer mould?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVALUATION

Evaluate yourself by checking your answers. If you have “NO” answers, revise the subjects related to these answers. If all the answers are “YES”, pass to other learning activities.
LEARNING ACTIVITY–3

AIM

When the required environment is provided, you will read and understand English terms as to drawing on computer with the help of CAD program.

SEARCH

The primary surveys that you have to carry out before this activity include:

- Search the computer programs used to make geometrical drawings on computer.
- Search the sectors design program is used in and the reasons why it is used.

3. COMPUTER MODELLING

3.1 Identification of Design program Screen

When Design program runs, Design program window opens. This window is where the required design and drawings are made. It is necessary to know the elements on the window to use the area effectively.
Drawings are made by using the commands received from the server on Design program screen. If information is needed to use the commands received, the server is resorted to. There are various ways to enter the command and information. It is necessary to know the program screen well in order to make use of these ways.

### 3.1.1. Toolbars

Toolbars are one of the drawing elements we come across when Design program screen first opens.

Toolbars include the tools representing the commands. To keep the cursor on a tool for a short time is enough to recognize the tools.

Toolbars that we come across when we click on the right button to insert the toolbars on the screen line up as in the figure 3.2
3D Orbit Toolbar

These are the toolbars controlling three dimensional images (Figure 3.3)

CAD Standards Toolbar

It is a toolbar enabling to control the layer, dimension and text styles according to the standards. (Figure 3.4)
Dimension Toolbar

It is a toolbar helping to design drawings you have made (Figure 3.5)

Draw Toolbar

It is a toolbar including the commands used to carry out the operations like line, circle, arch, square, and screening. (Figure 3.6)

Inquiry Toolbar

It is a toolbar including commands to find distance, point coordinates; object, mass properties and areas. (Figure 3.7)

Insert Toolbar

It is a toolbar including commands used to add the objects of different drawings (Figure 3.8)
Layouts Toolbar

It is a toolbar including commands used to see the insert of drawings (Figure 3.9)

Modify Toolbar

It is a toolbar including commands used to make modifications on the present objects. (Figure 3.10)

Modify 2 Toolbar

It is a toolbar including commands used for the modifications in special objects (Figure 3.11)

Object Properties Toolbar

It is a toolbar including commands to make drawings in line with their color, thickness, line type (Figure 3.12)

Object Snap Toolbar

It is a toolbar including commands used to pick up the objects from their special points. (Figure 3.13)
Refe dit Toolbar

It is a toolbar including commands enabling to make modifications on symbol or background drawings called as external reference drawings. (Figure 3.14)

Reference Toolbar

It is a toolbar including commands controlling cross-references of drawing. (Figure 3.15)

Render Toolbar

It is a toolbar including used to enable the render operations to show the three dimensional objects lifelike. (Figure 3.16)

Shade Toolbar

It is a toolbar including commands controlling the images of three dimensional objects. (Figure 3.17)

Solids Toolbar

It is a toolbar including the commands used to create three dimensional solid objects (Figure 3.18)
Solids Editing Toolbar

It is a toolbar including commands used to arrange three dimensional solid objects (Figure 3.19)

![Solids Editing Toolbar](image)

Figure 3.19

Standard Toolbar

It is a commonly used toolbar including many operations like fast file opening, saving, printing and zooming in (Figure 3.20)

![Standard Toolbar](image)

Figure 3.20

Surface Toolbar

It is a toolbar including commands used to create three dimensional objects. (Figure 3.21)

![Surface Toolbar](image)

Figure 3.21

Text Toolbar

It is a toolbar including commands used to create and arrange a text. (Figure 3.22)

![Text Toolbar](image)

Figure 3.22

UCS Toolbar

It is a toolbar including commands used to adjust the coordinate plane to be worked on. (Figure 3.23)

![UCS Toolbar](image)

Figure 3.23
UCS II Toolbar

It is a toolbar including commands used to choose among UCS’s defined beforehand. (Figure 3.24)

View Toolbar

It is a toolbar including commands used to see three dimensional objects and adjust the view you desire. (Figure 3.25)

Viewports Toolbar

It is a toolbar enabling to adjust many images on the objects drawn. (Figure 3.26)

Web Toolbar

It is a toolbar used to reach Web. (Figure 3.27)

Zoom Toolbar

It is a toolbar enabling you to move in the figure, zoom in and out it. (Figure 3.28)
Cursor

It is on the drawing line and used for the drawings with the help of mouse.

Mode Toolbar

It is under the command line, made up of coordinate display and a few shortcut keys.

Customize Toolbar

It is a toolbar enabling more commands to enter the toolbars emerging on the screen (Figure 3.29)

![Figure 3.29](image)

3.2. Design Program Drawing Commands

3.2.1. Line Command

- **Drawing a line:** There are three different ways to draw a line with Design program. These ways are shown below (Figure 3.30). To know the beginning and end points is adequate to define this line.

![Figure 3.30](image)
- **Drawing freely:** Line is written in the command line and then it is entered. (Figure 3.30). The message “From Point” in the command line requires entering the beginning point. First point is entered clicking on the left button of mouse and “To point” message in the command line requires entering the second point. If we continue, we keep clicking, but finish drawing line, we enter and leave the command. (Figure 3.31)

![Figure 3.31: Drawing lines with Line Command](image)

- **Drawing by Entering Coordinate:** Lines can be drawn by entering coordinates in x, y, z to the messages “From Point” and “to point”. If only x and y values are entered, x value is accepted 0.

- **Drawing by Entering Length and Angle:** After beginning point is entered to the message “From Point”, to the message “To Point” the length of line is entered for length and the angle that the line has created with hor is entered for angle in the way of “@length<angle”. The input of @50<90 enables drawing a line of 50 units and 90 degree.

The three ways mentioned can be used intertwined. That is, while the beginning point is drawn freely, the other point is drawn by entering length and angle.

In sum;

Menu: DRAW —LINE
Komut: line
Komut Kısaltma: L

Command: line
Specify first point: P1
Specify next point or [Undo]: P2
Specify next point or [Undo]: P3
Specify next point or [Close/Undo]: P4
Specify next point or [Close/Undo]: P5

![Diagram](image)
3.2.2. Polyline Command

It draws two dimensional polyline. To define simply, Polyline is a set of lines resembling Line but including lines added together and Arch segments. Its biggest difference from a normal line is that no matter how many segments it is made up of, it is a single object. When a polyline is selected at the end of drawing, all the segments are selected. In order to use this command:

- Polyline from Draw menu
- From Draw toolbar
- From Command window

Command is entered.

When a command is entered, the options are seen on the command window.

3.2.3. Multiline Command

It is made up of multi lines parallel to each other. It incorporates 16 parallel lines when a line is drawn between two points. It generally enables drawing layered constructional components like base, wall, and roof. In order to use this command:

- Multiline from Draw menu
- From Draw toolbar
- From Command window Mline is entered.

It is possible to see the options of this command on the command window.

**Justification:** It shows where the imaginary line will be in the multiline. There are three options which include Top on the multiline, Zero the centre of multiline and Bottom under multiline.

**Scale:** It calls multiline styles having been adjusted beforehand. To enter “?” is adequate to see the list. To create multiline style, Multiline Style is selected from Format menu or mlstyle from command window is needed to enter, so the users can create their multiline styles.

3.2.4. Construction Line Command

It draws infinite lines and these lines are used as helping lines in drawings. These lines reach the infinity fictionally and never take on a constructional task in a drawing. They are used with the aim of reference and can be selected and deleted if required. In order to use this command;
Construction Line from Draw menu
From Draw toolbar
From Command window, xline is entered

**Hor (horizontal):** It draws infinite line to the horizontal axis passing from the single point selected on the screen in the direction of parallel (x).

**Ver (vertical):** It draws an infinite line to the vertical axis passing from the single point selected on the screen in the direction of parallel (y).

**Ang (angle):** It draws an infinite line in the direction of angle given to a certain point.

**Bisect (bisector):** It draws an infinite line passing through the bisector of angle between first and second line.

**Offset:** It is used to draw an infinite line as offset.

### 3.2.5. Ray Command

It draws semi-infinite line. These lines are also used as helping lines like infinite lines that is, construction line. Semi-infinite line is a line whose beginning point is already defined and that extends to the infinity.

In order to use this command;

- Ray from Draw menu
- From Command window ray is entered.

There is nor any selection, but after the beginning point s entered, points are selected by turns and semi-infinite lines are drawn.

### 3.2.6. Spline Command

It draws a curve passing from the determined points and uses a special a curve type known as Design program BSpline. Spline is useful to create a uneven curve. Spline command produces curves to be defined as NURBS curves in private but spline curves in general. Spline makes up curves in tolerance between sequential points given. NURBS (nonuniform rational B-spline) mathematics, stores and defines a class of curve and surface data

In order to use this command;

- Spline from Draw menu
- From Draw toolbar
- From Command window Spline is entered.
The options;

**First Point;** the beginning point of curve is entered

**Next Point;** The points entered after the first point is called as next point and it adds curve components to the addition spline until the enter button is pressed. After the button of enter, Design program requires determination of beginning tangent.

**Close;** with completion of last point which provides combination tangent, spline skew is closed.

**Fit Tolerance;** changes tolerance in order it to be fit for actual spline. Skew is re-defined by being adapted to the new tolerance.

**Start Tangent;** specifies tangent for first and end points of skew.

**Object;** turns a combined line which is appropriate for spline from 2B or 3B second degree or third degree into an equivalent spline and erases combined line.

### 3.2.7. Point Command

- It draws point object.

In order to use this command;

- Point from Draw menu (Single point)
- from Draw toolbar
- Point is entered from Command window.

**Options;**

**Pdmode;** forms type of point which will be drawn.

**Pdsize;** controls size of the point which will be entered.

Type and size of the point can be chosen from Point Style dialogue box from Format menu besides Ddptype command. An intended type of point is chosen from this dialogue box.

Moreover, size of the point in this dialogue box can be given by choosing Point size as percentage. If Set Size Relative to Screen is chosen, size of the point is determined according to the screen. If one chooses Set Size in Absolute Units, size of the point is regarded as drawing and stays stable.

To sum up;
3.2.8. Trace Command

It draws concrete lines in 2D.

In order to use this command;

- Trace is entered from command window.

Edge points of Trace are on line axis and always cut as rectangular shape. Trace does not have undo option. When Fill mod is open, it draws a hard line whose interior part is full, when fill mod is closed it draws a hard line whose interior part is empty. When fill mod is changed for trace lines which are drawn before, one should enter regen command in order to upgrade drawing. Fill and regen commands are entered from command window.

3.2.9. Region Command

It forms a region object from choice set of present objects.

In order to use this command;

- Arc from Draw menu
- from Draw tool bar
- Arc is entered from Command window

Traces are 2D areas formed with closed shapes or cycles. Cycles are united skews whose planery area cannot be specified and have a border which does not intersect in itself. Cycles can be compound of line, combined line, circle, arc, ellipse, elliptic arc, 3B interface, trace and concrete backfill. Objects forming the cycle should be closed or in a shape of closed area whose edge points are shared with other objects. Objects should be in the same platform. If the original objects are scanned, related scanning becomes lost.
3.2.10. Sketch Command

It draws sketch. Free hand sketches are formed with several line pieces. In order to use this command;

- Sketch is entered from command window.

Options;
Record increment; specifies length of line part. Marking gadget should be moved in a value more than increment value in order to produce line. As record increment value increases line sensitiveness decreases. As these values increase, soft lines hardens.

Pen; upholds and downs sketch pen.

Exit-Enter; records the number of temporary lines whose sketches are made and reports and then finishes the command.

Quit; neglects all temporary lines whose sketches are made after using record option or start of sketch command.

Erase; draws any part of temporary line and uphold the pen if it is down.

Connect; downs the pen in order to continue sketching from the last erase process or edge point of line where sketch is made last.

Period; downs the pen and draws a straight line from edge point of last sketch work to current status of the pen and then upholds the pen.

3.2.11. Donut Command

It draws a circle whose interior part is full.

In order to use this command;

- Donut from Draw menu
- Donut is entered from Command window.

Donut is a combined and closed line formed with large arc pieces. Interior part of donut can be empty or full according to Fill command in other words according to its status as close or open. In order to draw a donut, one should state interior diameter, external diameter and center. If the interior diameter is zero, one obtains a circle whose interior part is full.
3.2.12. Boundary Command

Closed area or combined line is produced.

In order to use this command;

- Boundary from Draw menu
- Boundary is entered from command window.

Design program brings dialogue box into the screen in this command.

Options;

**Advanced Options:** methods are determined in order to form borders. These are boundary set, Island detection, and object type. Object type and island detection have two options.

**Internal Point:** produces border from present objects shaping the closed area.

3.2.13. Arc Command

You can use this command to draw an arc.

- Draw toolbar:
- Draw menu: Arc
- Command line: Arc
- Command: _arc Specify start point of arc or [CEnter]: (T1)
- Specify second point of arc or [CEnter/ENd]: (T2)
- Specify end point of arc. (T3)

After one enters Arc command, one should specify starting point and center point of the arc. Secondly, we can specify center point of the arc with Center option and end point with End option. In order to specify the command, one should press ENTER. (Picture 3.32)

![Picture 3.32 Using arc command](image)

After entering Arc command, in order to draw an arc tangent for a line last drawn or arc, press ENTER button. (Picture 3.33)
In order to form rectangular shapes, there are three different ways.

- Draw toolbar
- Draw menu: Rectangle
- Command line: Rectangle or rectangle

One can form a rectangular with an act with Rectangle command (Picture 3.34) after entering this command, one can add different features to the thing with given options.

Drawing rectangular by specifying two points
**Chamfer**: With this option, in line with X and Y axises it is possible to chamfer in intended values. (Picture 3.35)

- Command: Rectang
- Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: c
- Specify first chamfer distance for rectangles <0.0000>: 50
- Specify second chamfer distance for rectangles <6.0000>: 50
- Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:
- Specify other corner point:

Using Chamfer option in Rectang Command

![Picture 3.35](image)

**Elevation**: With this option one can specify height of rectangular in Z axis. (It is used in 3D drawings.)

**Fillet**: One specifies Radius value which will be given to rectangular. (Picture 3.36) it is used to draw corners of rectangular by rounding them.

- Command: Rectang
- Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: F
- Specify fillet radius for rectangles <0.0000>: 10
- Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]
- Specify other corner point:

Using Fillet option in Rectang Command

![Picture 3.36](image)
3.2.15. Polygon Command

It draws regular polygon forming in intended numbers of edges with this command.

Draw toolbar
Draw menu: Polygon symbol
Command line: Polygon

Things which are formed with Polygon command show features same with things formed with Polyline. Regulating things can be made with Edit Polyline.

After one enters Polygon command, the number of edges of an equilateral thing is specified and center point of the thing and edge length of it with edge option can be specified.

After one chooses center point, a tangent thing forms outside to the round which will form with length specified with Inscribed in circle option. a tangent thing forms outside to the round which will form with length specified with Circumscribed about circle option. One specifies radius value of the circle with Specify radius of circle option. (Picture 3.37)

![Picture 3.37: Using Polygon Command]
To sum up:

**3.2.16. Ellipse Command**

Ellipse command draws ellipse in an intended measures and location for the determined coordination. Ellipse is made as reflection of a circle which is twisted around parallel axis on drawing platform. ELLIPSE command forms drawn circle as small arc pieces. Then, these arc pieces can be united with PEDIT command.

- **Draw toolbar:**
  - Draw menu : Ellipse
  - Komut Satırı: Ellipse
  - Command : Ellipse
  - Specify axis endpoint of ellipse or [Arc/Center]:
  - Specify other endpoint of axis: 20
  - Specify distance to other axis or [Rotation]:
  - Options:
    - Axis Endpoint
    - Arc
    - Center
    - Isocircle

To sum up:

**Command:** ellipse

Specify axis endpoint of ellipse or [Center]. P1
Specify other endpoint of axis. P2
Specify distance to other axis or [Rotation]: H.
3.2.17. Circle Command

You can form rounds with this command. In order to make this, you can apply one of these ways.

- Draw toolbar;
- From Draw menu; Circle
- From Command line; Circle
- From Draw toolbar; Circle
- Specify center point for circle or [3P/2P/TTR ]:
  - Options:
    - Center Point
    - 3P (three points)
    - 2P (two points)
    - TTR—Tangent, Tangent, Radius

**Circle Command:** you can draw a circle by specifying a center point with this option. (Picture 3.38)

- Command: circle
- Specify center point for circle or [3P/2P/TTR (tan tan radius)];
- Specify radius of circle or [Diameter] <30.0000>: 25 (In order to specify radius of the circle, write R and enter its radius value. In order to enter radius value, one can enter directly the value.

Drawing a bow with Center Option

![Picture 3.38]

If one wants to make operation with a present value which is defined before, drawing can be fastened by directly pressing ENTER button. In order to enter a different value, one should press ENTER button by entering new value.
**Circle (3P-Three Points);** draws circle basing on these points as taking reference these points given on circumference of circle. (Picture 3.39)

- Command: circle
- Specify center point for circle or [3P/2P/TTR(tan tan radius)]: 3P
- Specify first point on circle: (P1)
- Specify second point on circle: (P2)
- Specify third point on circle: (P3)

Drawing circle with 3P option

![Picture 3.39](image)

**Circle (2P-Two points);** draws circle which will be drawn basing on these two points by regarding these two points as radius of the circle. (Picture 3.40)

- Command: circle
- Specify center point for circle or [3P/2P/TTR(tan tan radius)]: 2P
- Specify first end point of circle's diameter: (P1)
- Specify second end point of circle's diameter: (P2)

Drawing circle with 2P option

![Picture 3.40](image)
Circle TTR- Tangent, Tangent, Radius; It draws circle whose radius is given as it will be tangent to two points or a thing. (Picture 3.41)

Drawing circle with TTR option

- Command: circle
- Specify center point for circle or [3P/2P/TTR (tan tan radius)]
- Specify point on object for first tangent of circle
- Specify point on object for second tangent of circle
- Specify radius of circle <37.4732>: 60
- In short;

Menu: DRAW → CIRCLE
Komut: circle
Komut Kısaltma: C

Command: circle
Specify center point for circle or [3P/2P/TTR (tan tan radius)]; merkez belirtir
Specify radius of circle or [Diameter] <23.3016>: 20
If we are supposed to sum drawing commands;

**KOMUTLARIN ANLATIMI**

**Menü:** ANA MENÜ ADI → ALT MENÜ YADA KOMUT

**Komut:** komutun klavyeden karşılığı

**Komut Kısa:** komutun klavyedeki kısa yolu

**Örnek:**

**Çizgi Çizimi**

**Menü:** DRAW → LINE

**Komut:** line

**Komut Kısa:** L

**Komut Giriş ve Sonlandırma**

Command: *line*

Specify first point: 25.46

Specify next point or [Undo]: 52.63

Specify next point or [Undo]: L

Komutu yazıp enter e bas

Devamlı komutların sonlandırılması için boş enter e bas

**Komut Alternatifleri**

Command: *circle*

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 3P

Specify first point on circle: 25.46

Specify second point on circle: 45.50

Specify third point on circle: 100,250

3P, 2P, Ttr bunlar çizim alternatifleri

Komutu sonlandırılmak için boş enter e gerek kalmadı çünkü autocad’ın istediği her şeye cevap verdik. Komut kendiliğinden sonlandırıldı.

**Komut Esnasında Nesne Seçimi**

Command: break

Select object:

Specify second break point or [First point]: Fare yardımcıla nesneler seçilir.

Fare yardımcıyla ikinci noktası belirlir.

**Komuttan Çıkış**

Command: circle

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: “Cancel”

ESC tuşuya komut tamamlanmadan çıkılabılır

**Komut Esnasında Default Değerler**

Command: offset

## APPLICATION ACTIVITY

<table>
<thead>
<tr>
<th>Process Steps</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>➢ Load drawing programs to computer.</td>
<td>➢ Exercise Design program program.</td>
</tr>
<tr>
<td>➢ Make instruments for drawing ready.</td>
<td>➢ Open a new page belonging to you when Design program opens.</td>
</tr>
<tr>
<td></td>
<td>➢ Make adjustment you want by exercising drawing wizard on template page you think to use in your</td>
</tr>
<tr>
<td></td>
<td>drawing by using enterance frame.</td>
</tr>
<tr>
<td>➢ Adapt computer program according to drawing which will</td>
<td>➢ Load toolbars which are needed for drawing.</td>
</tr>
<tr>
<td>be done.</td>
<td>➢ For this, you can look at Tool Bars subject taking place in information pages.</td>
</tr>
<tr>
<td>➢ Determine process order of drawing.</td>
<td>➢ You can make easily your drawing if you first determine a process order for your drawing.</td>
</tr>
<tr>
<td>➢ Draw square, triangular and round. Record your drawing.</td>
<td>➢ Analyse your drawing you’re your instructor.</td>
</tr>
</tbody>
</table>

![Picture 3.42](image-url)
Assess what you have learnt in this activity by answering questions given below.

**Evaluate the answers of the questions given below as true (T) or false (F).**

1. ( ) Start from scratch is button for starting to draw.
2. ( ) One can make angle-angle measure by applying advanced setup.
3. ( ) Draw tool bar includes commands of distance, point coordination.
4. ( ) Grid makes us see our drawing border.
5. Which one given below is a command used to open a file?
   A) File
   B) Save
   C) Trim
   D) Move
   E) Rectangle

6. Which one given below is a command used to draw rectangular?
   A) Saveas
   B) Restangle
   C) Hatch
   D) Mirror
   E) Line

7. ( ) Standard toolbar is a tool bar which makes printing, enlarging.

8. ✗( ) is a polygon command.

**EVALUATION**

Compare your answers with answer key and determine your true answers’ number and evaluate yourself. Repeat subjects you answered wrong about this related subject. If you are successful, pass practicing test.
PERFORMANCE EVALUATION

Make basic drawings in design, extracting mould and computer you gained with module. Evaluate this practicing according to criteria given below.

<table>
<thead>
<tr>
<th>Evaluation Criteria</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Have you made sketch work?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Have you made a product design from the leathercraft?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mould</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Have you chosen a leathercraft product?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Have you prepared a model measure form?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Have you extracted all moulds appropriate for measure form?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Have you controlled if the moulds are right or not?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Model in computer</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Have you learnt functions of buttons in drawing programme in the computer?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Have you drawn triangular or round shape in the rectangular?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Have you recorded your drawings?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVALUATION

If you do not know everything about module, you can complete your knowledge by turning back to the related activities. If you complete the module successfully, you can pass the other module by consulting to your instructor.
THE ANSWER KEY

LEARNING ACTIVITY - 1 ANSWER KEY

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>2</td>
<td>True</td>
</tr>
<tr>
<td>3</td>
<td>False</td>
</tr>
<tr>
<td>4</td>
<td>True</td>
</tr>
<tr>
<td>5</td>
<td>False</td>
</tr>
</tbody>
</table>

LEARNING ACTIVITY - 2 ANSWER KEY

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>2</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>False</td>
</tr>
<tr>
<td>4</td>
<td>True</td>
</tr>
<tr>
<td>5</td>
<td>False</td>
</tr>
<tr>
<td>6</td>
<td>False</td>
</tr>
<tr>
<td>7</td>
<td>True</td>
</tr>
<tr>
<td>8</td>
<td>True</td>
</tr>
</tbody>
</table>

LEARNING ACTIVITY - 3 ANSWER KEY

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>True</td>
</tr>
<tr>
<td>2</td>
<td>True</td>
</tr>
<tr>
<td>3</td>
<td>False</td>
</tr>
<tr>
<td>4</td>
<td>True</td>
</tr>
<tr>
<td>5</td>
<td>B</td>
</tr>
<tr>
<td>6</td>
<td>B</td>
</tr>
<tr>
<td>7</td>
<td>True</td>
</tr>
<tr>
<td>8</td>
<td>True</td>
</tr>
</tbody>
</table>
 RESOURCE

- Vikipedi, Özgür Ansiklopedi.
- Saraciye Derneği Dökümanları, İstanbul.